Advance your everyday skills with Outlook 2013. And earn the credential that proves it!

Demonstrate your expertise with Microsoft Outlook! Designed to help you practice and prepare for Microsoft Office Specialist (MOS): Outlook 2013 certification, this official Study Guide delivers:

• In-depth preparation for each MOS objective
• Detailed procedures to help build the skills measured by the exam
• Hands-on tasks to practice what you’ve learned
• Ready-made practice files

Sharpen the skills measured by these MOS exam objectives:

• Manage the Outlook Environment
• Manage Messages
• Manage Schedules
• Manage Contacts and Groups

About MOS
A Microsoft Office Specialist (MOS) certification validates your proficiency with Microsoft Office programs, demonstrating you can meet globally recognized performance standards. Hands-on experience with the technology is required to successfully pass Microsoft Certification exams.

See full details at: microsoft.com/learning/certification

Practice Files
Available at: http://aka.ms/mosOutlook2013/files

MOS: Outlook 2013
Microsoft 2013 Study Guide • Microsoft Outlook • Exam 77-423

Microsoft Office Specialist
Exam 77-423

Sharpen the skills measured by these MOS exam objectives:

• Manage the Outlook Environment
• Manage Messages
• Manage Schedules
• Manage Contacts and Groups

Microsoft Press
Celebrating 30 Years!
MOS 2013 Study Guide for Microsoft Outlook

Joan Lambert
## Contents

**Introduction** ................................................................. vii
  Who this book is for .................................................. vii
  How this book is organized ........................................... vii
  Download the practice files .......................................... viii
    *Sidebar: Adapting exercise steps* ................................ ix
  Get support and give feedback ....................................... x
  Errata ........................................................................... x
  We want to hear from you ............................................ xi
  Stay in touch ................................................................ xi

**Taking a Microsoft Office Specialist exam** ............................ xiii
  Microsoft Office Specialist certification ............................. xiii
  Choosing a certification path .......................................... xiv
  Test-taking tips ............................................................ xiv
  Certification benefits ................................................... xvi
  For more information .................................................. xvi

**Exam 77-423 Microsoft Outlook 2013**

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prerequisites</td>
<td>1</td>
</tr>
<tr>
<td>Work in individual modules</td>
<td>2</td>
</tr>
<tr>
<td>Switch views</td>
<td>3</td>
</tr>
<tr>
<td>Create Outlook items</td>
<td>3</td>
</tr>
<tr>
<td>Address messages</td>
<td>4</td>
</tr>
</tbody>
</table>

What do you think of this book? We want to hear from you!
Microsoft is interested in hearing your feedback so we can continually improve our books and learning resources for you. To participate in a brief online survey, please visit: microsoft.com/learning/booksurvey
1 Manage the Outlook environment

1.1 Customize Outlook settings ......................................................... 6
   Customize the appearance of the program window ...................... 6
   Configure program options ....................................................... 11
   Set defaults for outgoing messages ........................................... 12
   Create and assign automatic signatures .................................... 15
   Configure options for multiple accounts ................................... 17
   Practice tasks ................................................................. 18

1.2 Automate Outlook ............................................................... 18
   Automatically reply to messages ............................................. 18
   Automatically process messages ............................................. 21
   Create and manage Quick Steps .............................................. 26
   Practice tasks ................................................................. 30

1.3 Print and save information in Outlook ..................................... 31
   View and save messages and attachments .................................. 31
   Print Outlook items .......................................................... 33
   Practice tasks ................................................................. 38

1.4 Search in Outlook ............................................................... 39
   Search for items ............................................................... 39
   Use Search Folders ............................................................. 41
   Practice tasks ................................................................. 43
   Objective review ............................................................... 43

2 Manage messages

2.1 Create messages ............................................................... 46
   Create and send messages ..................................................... 46
   Configure message options .................................................... 49
   Respond to messages .......................................................... 54
   Delegate access ................................................................. 56
   Practice tasks ................................................................. 58

2.2 Format messages ............................................................... 59
   Format text ........................................................................ 59
   Apply themes and styles ....................................................... 60
   Apply styles ....................................................................... 61
   Create hyperlinks ............................................................... 63
   Insert images ................................................................. 65
3 Manage schedules

3.1 Create and manage calendars ........................................ 86
   Configure calendar settings .................................... 86
   Work with multiple calendars .............................. 88
   Share calendar information ................................. 91
   Practice tasks ............................................... 94

3.2 Create appointments, meetings, and events .................. 95
   Create appointments and events ......................... 95
   Create meetings .......................................... 97
   Manage calendar items .................................. 101
   Practice tasks .......................................... 103

3.3 Organize and manage appointments, meetings, and events 104
   Configure settings for calendar items .................. 104
   Manage meeting options ................................ 106
   Practice tasks .......................................... 110

3.4 Create and manage notes, tasks, and journals .............. 110
   Create tasks ........................................... 110
   Manage tasks ......................................... 113
   Create and manage notes ................................ 115
   Create journal entries .................................. 118
   Practice tasks .......................................... 120

Objective review ................................................... 120
4 Manage contacts and groups

4.1 Create and manage contacts

Create and modify contact records
Store contact records
Share contact records and address books
Practice tasks

4.2 Create and manage groups

Practice tasks
Objective review

Index

About the author

Survey page

What do you think of this book? We want to hear from you!

Microsoft is interested in hearing your feedback so we can continually improve our books and learning resources for you. To participate in a brief online survey, please visit: microsoft.com/learning/booksurvey
Introduction

The Microsoft Office Specialist (MOS) certification program has been designed to validate your knowledge of and ability to use programs in the Microsoft Office 2013 suite of programs, Microsoft Office 365, and Microsoft SharePoint. This book has been designed to guide you in studying the types of tasks you are likely to be required to demonstrate in Exam 77-423: Microsoft Outlook 2013.

Who this book is for

*MOS 2013 Study Guide for Microsoft Outlook* is designed for experienced computer users seeking Microsoft Office Specialist certification in Outlook 2013.

The MOS exams for individual programs are practical rather than theoretical. You must demonstrate that you can complete certain tasks or projects rather than simply answering questions about program features. The successful MOS certification candidate will have at least six months of experience using all aspects of the application on a regular basis—for example, using Outlook at work or school to create and send messages, format message content, organize and manage messages, schedule appointments and events, manage meetings, create notes and journal entries, track tasks, store contact information, locate information, and print and save information. You should also know how to customize Outlook settings and automate tasks within Outlook.

As a certification candidate, you probably have a lot of experience with the program you want to become certified in. Many of the procedures described in this book will be familiar to you; others might not be. Read through each study section and ensure that you are familiar with not only the procedures included in the section, but also the concepts and tools discussed in the review information. In some cases, graphics depict the tools you will use to perform procedures related to the skill set. Study the graphics and ensure that you are familiar with all the options available for each tool.

How this book is organized

The exam coverage is divided into chapters representing broad skill sets that correlate to the functional groups covered by the exam, and each chapter is divided into sections addressing groups of related skills that correlate to the exam objectives. Each section
includes review information, generic procedures, and practice tasks you can complete on your own while studying. When necessary, we provide practice files you can use to work through the practice tasks. You can practice the procedures in this book by using the practice files supplied or by using your own files.

Download the practice files

Before you can complete the practice tasks in this book, you need to download the book’s practice files to your computer. These practice files can be downloaded from the following page:

http://aka.ms/mosOutlook2013/files

Important The Outlook 2013 program is not available from this website. You should purchase and install that program before using this book.

If you would like to be able to refer to the completed versions of practice files at a later time, you can save the practice files that you modify while working through the practice tasks in this book. If you save your changes and later want to repeat the practice task, you can download the original practice files again.

The following table lists the practice files for this book.

<table>
<thead>
<tr>
<th>Folder and chapter</th>
<th>Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>MOSOutlook2013\Objective1</td>
<td>n/a</td>
</tr>
<tr>
<td>1 Manage the Outlook environment</td>
<td></td>
</tr>
<tr>
<td>MOSOutlook2013\Objective2</td>
<td>Outlook_2-1a.docx</td>
</tr>
<tr>
<td>2 Manage messages</td>
<td>Outlook_2-1b.pptx</td>
</tr>
<tr>
<td></td>
<td>Outlook_2-2.docx</td>
</tr>
<tr>
<td>MOSOutlook2013\Objective3</td>
<td>Outlook_3-2.docx</td>
</tr>
<tr>
<td>3 Manage schedules</td>
<td></td>
</tr>
<tr>
<td>MOSOutlook2013\Objective4</td>
<td>Outlook_4-1.png</td>
</tr>
<tr>
<td>4 Manage contacts and groups</td>
<td></td>
</tr>
</tbody>
</table>
Adapting exercise steps

The screen images shown in this book were captured at a screen resolution of 1024 \times 768, at 100 percent magnification. If your settings are different, the ribbon on your screen might not look the same as the one shown in this book. For example, you might have more or fewer buttons in each of the groups, the buttons you have might be represented by larger or smaller icons than those shown, or the group might be represented by a button that you click to display the group's commands. As a result, exercise instructions that involve the ribbon might require a little adaptation. Our instructions use this format:

- On the **Insert** tab, in the **Illustrations** group, click the **Chart** button.

If the command is in a list or on a menu, our instructions use this format:

- On the **Home** tab, in the **Editing** group, click the **Find** arrow, and then click **Advanced Find**.

**Tip** On subsequent instances of instructions located on the same tab or in the same group, the instructions are simplified to reflect that we’ve already established the working location.

If differences between your display settings and ours cause a button to appear differently on your screen from the way it does in this book, you can easily adapt the steps to locate the command. First click the specified tab, and then locate the specified group. If a group has been collapsed into a group list or under a group button, click the list or button to display the group’s commands. If you can’t immediately identify the button you want, point to likely candidates to display their names in ScreenTips.

If you prefer not to have to adapt the steps, set up your screen to match ours while you read and work through the exercises in this book.

In this book, we provide instructions based on the traditional keyboard and mouse input methods. If you’re using the program on a touch-enabled device, you might be giving commands by tapping with a stylus or your finger. If so, substitute a tapping action any time we instruct you to click a user interface element. Also note that when we tell you to enter information, you can do so by typing on a keyboard, tapping an on-screen keyboard, or even speaking aloud, depending on your computer setup and your personal preferences.
Get support and give feedback

The following sections provide information about getting help with this book and contacting us to provide feedback or report errors.

Errata

We’ve made every effort to ensure the accuracy of this book and its companion content. Any errors that have been reported since this book was published are listed at:

http://aka.ms/mosOutlook2013/errata

If you find an error that is not already listed, you can report it to us through the same page.

If you need additional support, email Microsoft Press Book Support from:

mspinput@microsoft.com.

Please note that product support for Microsoft software is not offered through the addresses above.
We want to hear from you
At Microsoft Press, your satisfaction is our top priority, and your feedback our most valuable asset. Please tell us what you think of this book from:

http://www.microsoft.com/learning/booksurvey

The survey is short, and we read every one of your comments and ideas. Thanks in advance for your input!

Stay in touch
Let’s keep the conversation going! We’re on Twitter at:

http://twitter.com/MicrosoftPress
Taking a Microsoft Office Specialist exam

Desktop computing proficiency is increasingly important in today’s business world. When screening, hiring, and training employees, employers can feel reassured by relying on the objectivity and consistency of technology certification to ensure the competence of their workforce. As an employee or job seeker, you can use technology certification to prove that you already have the skills you need to succeed, saving current and future employers the time and expense of training you.

Microsoft Office Specialist certification

Microsoft Office Specialist certification is designed to assist employees in validating their skills with Office programs. The following certification paths are available:

- A Microsoft Office Specialist (MOS) is an individual who has demonstrated proficiency by passing a certification exam in one or more Office programs, including Microsoft Word, Excel, PowerPoint, Outlook, Access, OneNote, or SharePoint.

- A Microsoft Office Specialist Expert (MOS Expert) is an individual who has demonstrated that he or she has mastered the more advanced features of Word or Excel by passing the required certification exams.

- A Microsoft Office Specialist Master (MOS Master) is an individual who has demonstrated that he or she has mastered multiple Office applications by passing the MOS Expert certification exams for Word and Excel, the MOS certification exam for PowerPoint, and one additional MOS certification exam.
Choosing a certification path

When deciding which certifications you would like to pursue, you should assess the following:

- The program and program versions with which you are familiar
- The length of time you have used the program and how frequently you use it
- Whether you have had formal or informal training in the use of that program
- Whether you use most or all of the available program features
- Whether you are considered a go-to resource by business associates, friends, and family members who have difficulty with the program

Candidates for MOS-level certification are expected to successfully complete a wide range of standard business tasks, such as formatting a document or worksheet and its content; creating and formatting visual content; or working with SharePoint lists, libraries, Web Parts, and dashboards. Successful candidates generally have six or more months of experience with the specific Office program, including either formal, instructor-led training or self-study using MOS-approved books, guides, or interactive computer-based materials.

Candidates for MOS Expert-level certification are expected to successfully complete more complex tasks that involve using the advanced functionality of the program. Successful candidates generally have at least six months, and may have several years, of experience with the programs, including formal, instructor-led training or self-study using MOS-approved materials.

Test-taking tips

Every MOS certification exam is developed from a set of exam skill standards (referred to as the objective domain) that are derived from studies of how the Office programs are used in the workplace. Because these skill standards dictate the scope of each exam, they provide critical information about how to prepare for certification. This book follows the structure of the published exam objectives; see “How this book is organized” in the Introduction for more information.

The MOS certification exams are performance based and require you to complete business-related tasks or projects in the program for which you are seeking certification. For example, you might be presented with a file and told to do something specific with it, or presented with a sample document and told to create it by using resources provided for that purpose. Your score on the exam reflects how well you perform the requested tasks or complete the project within the allotted time.
Here is some helpful information about taking the exam:

- Keep track of the time. Your exam time does not officially begin until after you finish reading the instructions provided at the beginning of the exam. During the exam, the amount of time remaining is shown at the bottom of the exam interface. You can’t pause the exam after you start it.

- Pace yourself. At the beginning of the exam, you will receive information about the questions or projects that are included in the exam. Some questions will require that you complete more than one task. Each project will require that you complete multiple tasks. During the exam, the amount of time remaining to complete the questions or project, and the number of completed and remaining questions if applicable, is shown at the bottom of the exam interface.

- Read the exam instructions carefully before beginning. Follow all the instructions provided completely and accurately.

- Enter requested information as it appears in the instructions, but without duplicating the formatting unless you are specifically instructed to do so. For example, the text and values you are asked to enter might appear in the instructions in bold and underlined text, but you should enter the information without applying these formats.

- Close all dialog boxes before proceeding to the next exam question unless you are specifically instructed not to do so.

- Don’t close task panes before proceeding to the next exam question unless you are specifically instructed to do so.

- If you are asked to print a document, worksheet, chart, report, or slide, perform the task, but be aware that nothing will actually be printed.

- When performing tasks to complete a project-based exam, save your work frequently.

- Don’t worry about extra keystrokes or mouse clicks. Your work is scored based on its result, not on the method you use to achieve that result (unless a specific method is indicated in the instructions).

- If a computer problem occurs during the exam (for example, if the exam does not respond or the mouse no longer functions) or if a power outage occurs, contact a testing center administrator immediately. The administrator will restart the computer and return the exam to the point where the interruption occurred, with your score intact.
Certification benefits

At the conclusion of the exam, you will receive a score report, indicating whether you passed the exam. If your score meets or exceeds the passing standard (the minimum required score), you will be contacted by email by the Microsoft Certification Program team. The email message you receive will include your Microsoft Certification ID and links to online resources, including the Microsoft Certified Professional site. On this site, you can download or order a printed certificate, create a virtual business card, order an ID card, view and share your certification transcript, access the Logo Builder, and access other useful and interesting resources, including special offers from Microsoft and affiliated companies.

Depending on the level of certification you achieve, you will qualify to display one of three logos on your business card and other personal promotional materials. These logos attest to the fact that you are proficient in the applications or cross-application skills necessary to achieve the certification.

Microsoft Office Specialist  Microsoft Office Specialist Expert  Microsoft Office Specialist Master

Using the Logo Builder, you can create a personalized certification logo that includes the MOS logo and the specific programs in which you have achieved certification. If you achieve MOS certification in multiple programs, you can include multiple certifications in one logo.

For more information

To learn more about the Microsoft Office Specialist exams and related courseware, visit:

3 Manage schedules

The skills tested in this section of the Microsoft Office Specialist exam for Microsoft Outlook 2013 relate to managing calendars, calendar items, tasks, notes, and journal entries. Specifically, the following objectives are associated with this set of skills:

3.1 Create and manage calendars
3.2 Create appointments, meetings, and events
3.3 Organize and manage appointments, meetings, and events
3.4 Create and manage notes, tasks, and journals

Using the Microsoft Outlook 2013 calendar is a big step toward efficient time management. You can track appointments and events, and organize meetings. The Outlook calendar differentiates between working time and nonworking time—only working time is available to co-workers when they schedule meetings with you through Outlook. You can also configure the Outlook calendar to track your schedule in two time zones and smoothly switch between time zones when you travel.

In addition to the default Outlook calendar, you can create, import, link to, subscribe to, and manage other calendars within the Calendar module. And you can share your calendar information with other people in several ways; for example, you can share an entire calendar or only selected information with people inside or outside of your organization.

Outlook provides other modules in which to track information. The Tasks module provides a way to track independent tasks and messages that you want to follow up on, and to assign tasks to other people. You can display your daily task lists in the calendar to coordinate the time required to complete them. You can save general information in the Notes module. And you can record interactions that you have with specific people in the Outlook Journal module.

This chapter guides you in studying ways of managing calendars, appointments, meetings, and events; tracking tasks; and recording information in notes and journal entries.

**Practice Files** To complete the practice tasks in this chapter, you need the practice file contained in the MOSOutlook2013\Objective3 practice file folder. For more information, see “Download the practice files” in this book’s Introduction.
3.1 Create and manage calendars

Configure calendar settings

The Calendar module offers four distinct views of content. These views are:

- **Calendar** This is the standard view in which you display your Outlook calendar. In the Day, Work Week, or Week arrangement, Calendar view displays the subject, location, and organizer (if space allows) of each appointment, meeting, or event, in addition to the availability bar and any special icons, such as Private or Recurrence.

- **Preview** In the Day, Work Week, or Week arrangement, this view displays additional information, including information from the notes area of the appointment window, as space allows.

- **List** This list view displays all appointments, meetings, and events on your calendar.

- **Active** This list view displays only future appointments, meetings, and events.

In your Outlook calendar, the time that you indicate you are available for other people to schedule meetings with you is referred to as your work week. The calendar time slots within your work week are colored differently from those outside of your work week, and are the only time slots made available to people on your network when they are searching for a time to meet with you.
By default, the Outlook work week is defined as from 8:00 A.M. to 5:00 P.M. (in your local time zone), Monday through Friday. You can change this to match your individual work schedule. In Outlook 2013, you can specify a start time and end time for your standard work day, specify the days of the week that you work, and specify the day of the week that you’d like to appear first when you display only the work week in your calendar.

**Tip** Outlook doesn’t allow you to define a workday that crosses midnight or to define different start and end times for different days.

If you frequently travel or work with colleagues or clients outside of your usual time zone, you might want to change the time zone on your computer so that information such as the receipt time of email messages, appointment times, and the time on the clock in the Windows Taskbar notification area reflects your current location. If you have appointments in both time zones, you can display both time zones on the left side of the Calendar pane, and swap between zones when you travel. That way, you can be sure to correctly enter appointments at the time they will occur in their respective time zones.

**To display a different calendar view**
- On the View tab, in the Current View group, click the Change View button, and then click Calendar, Preview, List, or Active.

**To modify the time period shown in Calendar view or Preview view**
- On the View tab, in the Arrangement group, click the Day, Work Week, Week, or Month button.
- In the Arrangement group, click the Schedule View button. Then in the Time Scale list, click 60 Minutes, 30 Minutes, 15 Minutes, 10 Minutes, 6 Minutes, or 5 Minutes.

**To modify the grouping of calendar items in List view or Active view**
- On the View tab, in the Arrangement gallery, click Categories, Start Date, Recurrence, or Location.
- Right-click any column heading, and then click Group By This Field.

**To sort calendar items in List view or Active view**
- Click any column heading to sort by the values in that column.
- Click the active sort column heading to reverse the sort order.
- On the View tab, in the Arrangement group, click the Reverse Sort button.
Chapter 3 Manage schedules

To set work times on the default calendar

1. Open the Outlook Options dialog box. On the Calendar page, in the Work time area, set the start time and end time of the work day you want to define.

2. In the Work week area, select the check boxes of the days you want to include in your work week.

3. In the First day of week list, click the day you want to appear first (on the left) in the Work Week view of your calendar.

4. In the First week of year list, click Starts on Jan 1, First 4-day week, or First full week.

To change the calendar time zone

1. Open the Outlook Options dialog box. On the Calendar page, in the Time zones area, click the Time zone list, and then click the time zone you want to display.

2. In the corresponding Label box, enter a description of up to 32 characters.

To display multiple time zones

1. On the Calendar page of the Outlook Options dialog box, in the Time zones area, select the Show a second time zone check box.

2. In the corresponding Time zone list, click the second time zone you want to display.

3. In the corresponding Label box, enter a description of up to 32 characters.

To switch your calendar between the primary and secondary time zones

On the Calendar page of the Outlook Options dialog box, in the Time zones area, click the Swap Time Zones button.

Work with multiple calendars

The Calendar button on the Navigation Bar links to the calendar of your default email account. In addition, you can display the following types of calendars in the Calendar module:

- Calendars of your other email accounts These are available automatically when you configure Outlook to connect to an account.

- Custom calendars You create a calendar in the same way that you do a folder that contains mail, contact records, or other items.
3.1 Create and manage calendars

- **Calendars of people within your organization**  Within an organization that uses Microsoft Exchange Server, you can display the availability of your co-workers, individually or in a group, without special permission.

- **Shared calendars**  Other Outlook users can share their calendars with you.

- **SharePoint site calendars**  You can connect a SharePoint calendar to Outlook.

- **Internet calendars**  You can subscribe to or import calendars from the Internet.

All these types of calendars are available to you from the Folder Pane in the Calendar module or the Folder List in the Mail module.

You can display calendars individually, or you can display more than one calendar at a time. For example, you might have separate business and personal calendars and want to view them together. You can view multiple calendars next to each other, or you can overlay them to display a composite view of the separate calendars. When you view and scroll through multiple calendars, they all display the same date or time period.
To display or hide multiple calendars

- In the Folder Pane of the Calendar module, select or clear the check box of individual calendars.
- In the Folder Pane of the Mail module, expand the Folder List, and then click a calendar to display it.

To create a secondary calendar

1. Display the Calendar module. On the Folder tab, in the New group, click the New Calendar button.
2. In the Create New Folder dialog box, name the calendar, select its location, and then click OK.

To create a calendar group by choosing group members

1. Display the Calendar module. On the Home tab, in the Manage Calendars group, click the Calendar Groups button and then, in the list, click Create New Calendar Group.
2. In the Create New Calendar Group dialog box, enter a name for the group, and then click OK.
3. In the Select Name dialog box, double-click the names of the people whose calendars you want to include in the calendar group to add them to the Group Members box, and then click OK.

Tip You can display an up-to-date group schedule at any time by selecting the check box of the calendar group in the Folder Pane. You can hide the group schedule by clearing the check box.

To create a calendar group containing the currently displayed calendars

1. On the Home tab, in the Manage Calendars group, click the Calendar Groups button and then, in the list, click Save as New Calendar Group.
2. In the Create New Calendar Group dialog box, enter a name for the group, and then click OK.
3.1 Create and manage calendars

➢ **To delete a calendar group**

1. In the Folder Pane, right-click the name of the calendar group, and then click Delete Group.
2. In the confirmation dialog box, click Yes.

➢ **To delete a calendar from the Calendar module or from a calendar group**

➔ In the Folder Pane, right-click the calendar name, and then click Delete Calendar.

➢ **To switch between Overlay Mode and Side-By-Side Mode**

➔ On the title bar tab of any secondary calendar, click the View in Overlay Mode button. In Overlay Mode, click either calendar tab to display that calendar on top of the other calendar.

➔ On any overlaid calendar, click the View in Side-By-Side Mode button to return to the standard display.

➔ Right-click any calendar tab, and then click Overlay to turn Overlay Mode on or off for that calendar.

**Share calendar information**

Co-workers can view your available working time when they schedule meetings with you or view your calendar through Outlook. If you want to share more information with co-workers or with people outside of your organization, you have several options for doing so.

- You can allow selected co-workers to view calendar item details by sharing the calendar with them.

- You can allow selected co-workers to view your entire calendar and to make appointments and respond to meeting requests on your behalf by delegating control of the calendar to them.

- You can publish your calendar to the Office.com website or to a corporate web server and then share the published calendar with any person who has access to the Internet.

- You can send a professional graphic representation of your appointments during a selected date range by email to any person who uses an HTML-capable email program (not only people who use Outlook), including colleagues, friends, and family members.
The options for sending, sharing, and publishing calendar information are available from the Share group on the Home tab of the Calendar module.

**See Also** For information about delegating access to your calendar, see “Delegate access” in section 2.1, “Create messages.”

If your email address is part of an Exchange network, you can give permission to other people on your network to view, modify, or create items within a calendar or any other type of Outlook folder. The level of access each co-worker has is governed by the permissions you assign to him or her. Using this method, you can share your default calendar or a secondary calendar that you create, import, or subscribe to.

After you share a calendar, you can specify the actions each person with whom you share the calendar can take. You can select a permission level, which includes Read, Write, Delete, and other settings, or you can select individual settings in each category.

**Tip** From the Permissions page, you can change the default permission level to your calendar and permit co-workers to view more information than only your availability.
To share a calendar

1. In the Calendar module, display the calendar you want to share.

2. On the Home tab, in the Share group, click the Share Calendar button to create a sharing invitation.

3. Address the invitation to the person with whom you’d like to share your calendar. If you’d like to request that the person reciprocate by sharing his or her calendar with you, select the Request permission to view recipient’s Calendar check box.

4. In the Details list, click the level of detail you want to share: Availability only, Limited details, or Full details.

5. Add any notes you want to in the content pane, send the message, and then click Yes in the Microsoft Outlook dialog box that asks you to confirm that you want to share the calendar with the specified permissions.
To configure permissions for a shared calendar

1. On the Home tab, in the Share group, click the Calendar Permissions button.
2. On the Permissions page of the Calendar Properties dialog box, click a pre-configured permission level in the Permission Level list, or select individual options.

Practice tasks

There are no practice files for these tasks. Before you begin, alert a colleague that you are going to practice sharing your calendar.

- Display your primary calendar for next month.
- Display only the second week of the month.
- Display only the fifteenth day of the month.
- Create a secondary calendar named MOS Schedule, and display it beside your primary calendar.
- Create a calendar group named MOS Team that includes the secondary calendar and the calendar of a colleague, and display the calendar group in Schedule view.
- Display the MOS Team calendar group in Overlay Mode.
- Delete the MOS Team calendar group.
- Hide the MOS Schedule calendar.
3.2 Create appointments, meetings, and events

Create appointments and events

Appointments are blocks of time you schedule for only yourself (as opposed to meetings, to which you invite other people). An appointment has a specific start time and end time.

Events occur for one or more 24-hour days—for example, a birthday, a vacation week, or anything else occurring on specific days but not beginning and ending at specific times. In all other respects, creating an event is identical to creating an appointment, in that you can specify a location, indicate recurrence, indicate your availability, and attach additional information to the event item.

You can schedule a simple appointment or event directly on the calendar, or provide additional details in an appointment window. The minimum requirements are a subject and a time slot. You can also include the appointment location and enter additional information (including formatted text, website links, and even file attachments) in a notes area so that it is readily available to you at the time of the appointment.

When creating an appointment, meeting, or event, you indicate your availability (also referred to as Free/Busy time) by marking it as Free, Working Elsewhere, Tentative, Busy, or Out Of Office. The appointment time is color-coded on your calendar to match the availability you indicate. Your availability is visible to other Outlook users on your network, and is also displayed when you share your calendar or send calendar information to other people.
To create an appointment with the default settings

1. In the Calendar module, display the date on which you want to schedule the appointment.
2. In the Calendar pane, click the desired time slot, or drag through consecutive time slots.
3. Enter the information you want to appear as the appointment subject, and then press Enter.

To open a new appointment window

1. In the Calendar module, on the Home tab, in the New group, click the New Appointment button.
2. In the Calendar module, press Ctrl+N.
3. In any module, on the Home tab, in the New group, click the New Items button, and then click Appointment.
4. In any module, press Ctrl+Shift+A.

To create an appointment with custom settings

1. Open a new appointment window.
2. In the appointment window, enter the information you want to appear on the calendar in the Subject and Location boxes.
3. Click or enter the appointment start date in the left Start time list and, if the appointment extends across multiple days, click or enter the appointment end date in the left End time list.
4. Click or enter the appointment start time in the right Start time list and the appointment end time in the right End time list.
5. On the Appointment tab, in the Options group, click your availability during the specified appointment time—Free, Working Elsewhere, Tentative, Busy, or Out of Office—in the Show As list.
6. In the Options group, in the Reminder list, click the length of time prior to the appointment (or None) when you would like Outlook to display an appointment reminder.
7. On the Appointment tab, in the Actions group, click the Save & Close button.
To create an appointment from an email message
1. In the Mail module, drag the message from the Mail pane to the Calendar button on the Navigation Bar.
2. In the appointment window that opens, edit the appointment details as necessary.
3. On the Appointment tab, in the Actions group, click the Save & Close button.

To create an event with default settings
1. Display the calendar in Day view, Work Week view, or Week view, or Month view.
2. In the Calendar pane, click the space that contains the date (in views other than Month view, the space below the day header and above the time slots).
3. Enter the event name, and then press Enter.

To create an event with custom settings
- In an appointment window header, to the right of the Start time boxes, select the All day event check box.

Create meetings
A primary difficulty when scheduling a meeting is finding a time that works for all the people who need to attend it. Scheduling meetings through Outlook is significantly simpler than other methods of scheduling meetings, particularly when you need to accommodate the schedules of several people. Outlook displays the individual and collective schedules of people within your own organization, and of people outside of your organization who have published their calendars to the Internet. You can review attendees’ schedules to locate a time when everyone is available, or have Outlook find a convenient time for you.

You can send an Outlook meeting invitation (referred to as a meeting request) to any person who has an email account—even to a person who doesn’t use Outlook. You can send a meeting request from any type of email account (such as an Exchange account or an Internet email account).

The meeting window has two pages: the Appointment page and the Scheduling Assistant page. The Appointment page is visible by default. You can enter all the required information directly on the Appointment page, or use the additional features available on the Scheduling Assistant page to find the best time for the meeting.
Chapter 3  Manage schedules

The Room Finder is open by default on the right side of each page of the meeting window. This handy tool helps you to identify dates and times that work for the greatest number of attendees, in addition to available locations. The monthly calendar at the top of the Room Finder indicates the collective availability of the group on each day, as follows:

- Dates that occur in the past and nonworking days are gray.
- Days when all attendees are available are white (Good).
- Days when most attendees are available are light blue (Fair).
- Days when most attendees are not available are medium blue (Poor).

**Tip** All the capabilities for the Room Finder are available for Exchange accounts, but functionality is limited for other types of accounts. You can display or hide the Room Finder page by clicking the Room Finder button in the Options group on the Meeting tab.

Managed conference rooms that are available at the indicated meeting time are shown in the center of the Room Finder. At the bottom of the Room Finder, the Suggested
3.2 Create appointments, meetings, and events

Times list displays attendee availability for appointments of the length of time you have specified for the meeting.

People you invite to meetings are referred to as attendees. By default, the attendance of each attendee is indicated as Required. You can inform noncritical attendees of the meeting by marking their attendance as Optional. You can invite entire groups of people by using a contact group or distribution list. You can also invite managed resources, such as conference rooms and audio/visual equipment, that have been set up by your organization’s Exchange administrator.

A meeting request should have at least one attendee other than you, and must have a start time and an end time. It should also include a subject and a location, but Outlook will send the meeting request without this information if you specifically allow it. The body of a meeting request can include text and web links, and you can also attach files. This is a convenient way to distribute meeting information to attendees ahead of time.

The secondary page of the meeting window is the Scheduling Assistant page, if your email account is part of an Exchange Server network. Otherwise, the secondary page is the Scheduling page, which doesn’t include the Room Finder feature.
Chapter 3  Manage schedules

The Scheduling and Scheduling Assistant pages include a group schedule that shows the status of each attendee’s time throughout your working day. Outlook indicates your suggested meeting time on the group schedule. If free/busy information is available for meeting attendees, the status is indicated by the standard free/busy colors and patterns that match the legend at the bottom of the page. If no information is available (either because Outlook can’t connect to an attendee’s calendar or because the proposed meeting is further out than the scheduling information stored on the server), Outlook shows the time with gray diagonal stripes. The row at the top of the schedule, to the right of the All Attendees heading, indicates the collective schedule of all the attendees.

➤ To open a new meeting window
   ➤ In the Calendar module, on the Home tab, in the New group, click the New Meeting button.
   ➤ In any module, on the Home tab, in the New group, click the New Items button, and then click Meeting.
   ➤ In any module, press Ctrl+Shift+Q.

➤ To create a meeting from an email message
   ➤ In the message reading window, on the Message tab, in the Respond group, click the Meeting button.

➤ To convert an appointment or event to a meeting
   ➤ In an appointment or event window, on the item-specific tab, in the Attendees group, click the Invite Attendees button.
   ➤ In an appointment or event window, on the item-specific tab, in the Show group, click the Scheduling Assistant button.

➤ To invite attendees and schedule resources
   ➤ On the Appointment page of the meeting window, enter the email addresses or names of the attendees or resources in the To box.
   ➤ On the Scheduling or Scheduling Assistant page of the meeting window, enter the email addresses or names of the attendees and resources in the All Attendees list.

    Or

1. On the Appointment page of the meeting window, click the To button.
2. In the Select Attendees and Resources dialog box, locate and double-click the names of the contacts and managed resources you want to invite, and then click OK.
3.2 Create appointments, meetings, and events

To invite optional attendees

1. Invite the attendee by using any of the previously discussed methods.
2. On the Meeting tab, in the Show group, click the Scheduling Assistant button.
3. In the All Attendees list, click the icon immediately to the left of the optional attendee’s name and then, in the list, click Optional Attendee.

To use the Room Finder

- To display suggested meeting times, click a date in the Date Navigator at the top of the Room Finder pane.
- To update the meeting request, click a meeting time in the Suggested Times list.

Manage calendar items

If you have the same appointment on a regular basis—for example, a bimonthly haircut or a weekly exercise class—you can set it up in your Outlook calendar as a recurring appointment. A recurring appointment can happen at almost any regular interval, such as every Tuesday and Thursday, every other week, or the last day of every month. Configuring an appointment recurrence creates multiple instances of the appointment in your calendar at the time interval you specify. You can set the appointment to recur until further notice, to end after a certain number of occurrences, or to end by a certain date. The individual appointments are linked. When making changes to a recurring appointment, you can choose to update all occurrences or only an individual occurrence of the appointment.

![Appointment Recurrence dialog box](image-url)
To configure recurrence for calendar items

1. On the item-specific tab of the item window, in the Options group, click the Recurrence button.

Or

In the Calendar pane, select the calendar item. On the item-specific tool tab, in the Options group, click the Recurrence button.

2. In the Appointment Recurrence dialog box, do the following, and then click OK:
   a. In the Recurrence pattern area, click a frequency option.
   b. In the adjacent area, which changes according to the frequency option you select, adjust the settings to reflect the recurrence you want.
   c. In the Range of recurrence area, select the appropriate end date for the series of appointments or events.

To categorize calendar items

 ➤ On the item-specific tab of the item window, in the Tags group, click the Categorize button, and then click the category you want to assign.

 ➤ In the Calendar pane, select the calendar item. On the item-specific tool tab, in the Tags group, click the Categorize button, and then click the category you want to assign.

 ➤ In the Calendar pane, right-click the calendar item, click Categorize, and then click the category you want to assign.

To change the time of an existing calendar item

 ➤ In the Calendar pane, drag the item to a different date or to a different time slot.

 ➤ In the Calendar pane, in Day view, Work Week view, or Week view, drag the top or bottom border of an appointment or meeting up or down to change the start or end time.

 ➤ In the Calendar pane, click an appointment or meeting one time to select it, press Ctrl+X, click the time slot to which you want to move the item, and then press Ctrl+V.

 ➤ In the item window, adjust the Start time and End time settings. Then on the item-specific tab, in the Actions group, click the Save & Close button.
3.2 Create appointments, meetings, and events

➢ To create a copy of an existing appointment

1. In the Calendar pane, display the original appointment day and the day to which you want to copy the appointment.

2. Hold down the Ctrl key, and drag the appointment to the new date or time slot.

Practice tasks

The practice file for these tasks is located in the MOSOutlook2013\Objective3 practice file folder. Before you begin, alert two colleagues that you are going to practice scheduling meetings.

- Display tomorrow’s date in the Calendar pane. Create a half-hour appointment from 11:30 A.M. to 12:00 P.M., with the subject MOS Lunch with Jane. Accept all other default settings.

- Without opening the appointment window, change the start time of the MOS Lunch with Jane appointment to 10:30 A.M and the end time to 11:30 A.M.

- Specify the location of the MOS Lunch with Jane appointment as Fourth Coffee. Set the appointment options so that other Outlook users know that you will be out of the office from 10:30 A.M. to 11:30 A.M. but can’t view any appointment details.

- Create a recurring one-hour appointment on the first Monday of the month at 6:00 P.M. with the subject MOS Book Club. Set the series to end after six occurrences.

- Create a two-day event on Tuesday and Wednesday two weeks from now in Portland, Oregon, with the subject MOS Annual Meeting and Retreat. Attach the Outlook_3-2 document to the event.

- Create a request for a half-hour meeting with a colleague, with the subject MOS Status Meeting, at 3:00 P.M. tomorrow. Enter Test – please accept in the Location box, and send the request to one person.

- Add a second colleague as an optional attendee to the meeting request for the MOS Status Meeting, and then send the meeting request only to the new attendee.

- Schedule a one-hour MOS Budget Meeting with two colleagues at the first available time next week. Set up this meeting to occur at the same time every month for three months.
3.3 Organize and manage appointments, meetings, and events

Configure settings for calendar items

As you can with other Outlook items, you can set the importance of a calendar item. Unlike other items, however, the importance is visible only in the open item window. However, you can use the importance setting, as you can any tag, as a way of locating specific calendar items.

By default, Outlook displays a reminder message 15 minutes before the start time of an appointment or meeting, and 18 hours before an all-day event—you can change the reminder to occur as far as two weeks in advance, or you can turn it off completely if you want to.

You might find it necessary to change the date, time, or location of an appointment, meeting, or event. When you are the meeting organizer, you can change any information in a meeting request at any time, including adding or removing invited attendees.
To cancel a meeting, click the meeting on your calendar or open the meeting window, and then click the Cancel Meeting button in the Actions group on the Meeting or Meeting Series tab.

After you edit or cancel a meeting, Outlook sends an updated meeting request to the invited attendees to keep them informed. If the only change you make is to the attendee list, Outlook gives you the option of sending an update only to the affected attendees.

➤ **To set calendar item importance**

- On the item-specific tab of the item window, in the Tags group, click the High Importance button or Low Importance button.
- In the Calendar pane, select the item. On the item-specific tool tab, in the Tags group, click the High Importance button or Low Importance button.

**Tip** If you set the importance of a single occurrence of a recurring item, the High Importance and Low Importance buttons are unavailable in the Calendar pane.

➤ **To configure reminders**

- On the item-specific tab of the item window, in the Options group, in the Reminder list, click the amount of time prior to the item start time that you want the reminder time to appear.
- In the Calendar pane, select the item. On the item-specific tool tab, in the Options group, in the Reminder list, click the amount of time prior to the item start time that you want the reminder time to appear.

➤ **To update calendar items**

1. Double-click the item on your calendar.
2. If the item is one of a series (a recurring item), click to indicate whether you want to edit the series or only the selected instance.
3. Make the changes you want, and then save the item.
4. If the item is a meeting, send the meeting update to the attendees.
Manage meeting options

When you receive a meeting request from another Outlook user, the meeting appears on your calendar with your time scheduled as Tentative. Until you respond to the meeting request, the organizer doesn’t know whether you plan to attend.

By default, meeting requests that you send include a standard set of response options. You can respond to a meeting request in one of these four ways:

- **Accept the request.** Outlook deletes the meeting request and adds the meeting to your calendar.
- **Tentatively accept the request,** which indicates that you might be able to attend the meeting but are undecided. Outlook deletes the meeting request and shows the meeting on your calendar as tentatively scheduled.
- **Propose a new meeting time.** Outlook sends your request to the meeting organizer for confirmation and shows the meeting with the original time on your calendar as tentatively scheduled.
- **Decline the request.** Outlook deletes the meeting request and removes the meeting from your calendar.

In addition to these, you have the option to reply to the meeting organizer or to all attendees, or to forward the meeting request. When you forward a meeting request for which you are not the organizer, the meeting request is sent from you “on behalf of” the meeting organizer, and responses are sent to the meeting organizer.
If you don’t respond to a meeting request, the meeting remains on your calendar with your time shown as tentatively scheduled and the meeting details in gray font rather than black.

If you’re unsure whether a meeting time works for you, you can click the Calendar Preview link in the meeting request to display your calendar for the time period immediately surrounding the meeting, or you can click the Calendar button at the top of the meeting request to open your default calendar for the suggested meeting day in a separate window. If the meeting time doesn’t work for you, you can propose a new time.
When accepting or declining a meeting, you can choose whether to send a response to the meeting organizer. If you don’t send a response, your acceptance will not be tallied, and the organizer will not know whether you are planning to attend the meeting. If you do send a response, you can add a message to the meeting organizer before sending it.

If you are the meeting organizer, you can add an attendee to a meeting at any time. If this is the only change you make to the attendee list, Outlook gives you the option of sending an update only to the new attendee.

You can take notes for any meeting in Microsoft OneNote. If you originate the notes from within the meeting request, the notes are linked to the meeting request and include all the information from the meeting request, in addition to a link back to it. If you store the notes in a shared OneNote notebook, you can make the notes available to other meeting attendees.

➤ **To respond to meeting invitations**

1. In the meeting window, in the Reading Pane, or on the shortcut menu that appears when you right-click the meeting request, click Accept, Tentative, or Decline.
2. Choose whether to send a standard response, a personalized response, or no response at all.

➤ **To propose a new time for a meeting**

1. In the meeting window or in the Reading Pane, click Propose New Time, and then click Tentative and Propose New Time or Decline and Propose New Time to open the Propose New Time dialog box.
2. In the Propose New Time dialog box, change the meeting start and end times to the times you want to propose, either by dragging the start time and end time bars or by changing the date and time in the lists, and then click the Propose Time button.
3. In the meeting response window that opens, enter a message to the meeting organizer if you want to, and then click Send to send your response and add the meeting to your calendar as tentatively scheduled for the original meeting time. If the meeting organizer approves the meeting time change, you and other attendees will receive updated meeting requests showing the new meeting time.
3.3 Organize and manage appointments, meetings, and events

To forward meeting requests
1. In the meeting window, on the Meeting or Meeting Series tab, in the Respond group, click the Respond button, and then click Forward.
2. Enter the recipient’s email address and send the meeting request.

To add meeting participants
1. Display the meeting window and enter new attendees by using any of the previously described methods.
2. To the left of the To box, click the Send Update button.
3. In the Send Update to Attendees dialog box, click Send updates only to added or deleted attendees, and then click OK.

To share meeting notes
1. In the meeting window, on the Meeting or Meeting Series tab, in the Meeting Notes group, click the Meeting Notes button.
2. In the Meeting Notes window, click Share notes with the meeting or Take notes on your own.
3. In the Choose Notes to Share with Meeting or Select Location in OneNote dialog box, select the OneNote location in which you want to store the meeting notes, and then click OK.
4. Record your meeting notes in the OneNote window that opens.

To cancel meetings
1. In the meeting window, on the Meeting or Meeting Series tab, in the Actions group, click the Cancel Meeting button.
2. In the message header, click the Send Cancellation button.
Practice tasks

Use the MOS Budget Meeting and MOS Status Meeting meetings that you created in section 3.2 as practice files for these tasks.

- Set a reminder for the MOS Lunch with Jane appointment to appear at 9:30 A.M.
- Reschedule the MOS Budget Meeting to the week after next, indicate that the meeting is high priority, and then send the updated meeting request.
- Ask a colleague to send you a meeting request for a meeting with the subject MOS Project Meeting. When the meeting request arrives, tentatively accept the meeting and propose that the meeting be held at the same time on the following day.
- From the meeting window, create a shared notes page for the MOS Project Meeting in OneNote.
- Cancel the MOS Status Meeting and MOS Budget Meeting meetings and send cancellation notices to the attendees.

3.4 Create and manage notes, tasks, and journals

Create tasks

If you use your Outlook task list to its fullest potential, you’ll frequently add tasks to it. You can create tasks in several ways:

- In the Tasks module, add a task to the task list.
- In other modules, add a task to the Tasks peek.
- Create a new task in the task window.
- Base a task on an existing Outlook item (such as a message).

Just as you can create recurring appointments, events, and meetings, you can create recurring tasks. You can set the task to occur every day, week, month, or year; or you can specify that a new task should be generated a certain amount of time after the last task is complete.
3.4 Create and manage notes, tasks, and journals

Regardless of how or where you create a task, all tasks are available in the Tasks module and in the Tasks peek. Only individual tasks are available in the Tasks List.

You might frequently need to take action based on information you receive in Outlook—for example, information in a message or in a meeting request. You might want to add information from another Outlook item to your task list, to ensure that you complete any necessary follow-up work. Depending on the method you use, you can either create a new task from an existing item or simply transfer the existing item to your task list by flagging it.

**Tip** When viewing your calendar in Day, Work Week, or Week view, each item on your Outlook task list appears in the Tasks section below its due date. You can schedule specific time to complete a task by dragging it from the Tasks area to your calendar.

➤ **To create a task in the Tasks module**

- On the Home tab, in the New group, click the New Task button. Enter the task details in the task window that opens, and then save and close the task.

- When displaying the To-Do List view of the Tasks module, enter the task description in the Type a new task box, and then press Enter to create a task with the default settings.

- When displaying the Tasks List view of the Tasks module, enter the task description in the Click here to add a new Task box, press Tab to move to subsequent fields, fill in other information, and then press Enter.
To create a task in any module

- On the Home tab, in the New group, in the New Items list, click Task.
- Press Ctrl+K.
- In the Tasks peek, enter the task description in the Type a new task box.

To create a task from an email message, contact record, or note

- Drag the message, contact record, or note to the Tasks button on the Navigation Bar. Close and save the task window that contains the information from the original item.

To transfer an email message to your task list without creating an individual task

- In the Mail pane, click the flag icon to the right of a message.
- This method, referred to as flagging a message for follow-up, adds the message to your task lists with the default due date specified in the Quick Click settings, and adds an information bar to the message. However, it does not create a separate task item, so to retain the task, you must retain the message—you can move the message between mail folders, but deleting the message deletes the task as well.
- In the Mail pane, right-click the flag icon to the right of a message, and then specify a due date: Today, Tomorrow, This Week, Next Week, No Date, or Custom (which allows you to set specific start and end dates).
- Drag the message to the Tasks peek and drop it under the heading for the due date you want to assign it to. (If the desired due date doesn’t already have a heading in the Tasks peek, you need to drop the message under another heading and then assign the due date you want.)
- This method also adds the message to your task list but doesn’t create a separate task item.
Manage tasks

To help you organize your tasks, you can assign them to color categories in the same way that you do any other Outlook item.

When you create a task item, the only information you must include is the subject. As with many other types of Outlook items, you can set several options for tasks to make it easier to organize and identify tasks.

- **Start date and due date** You can display tasks on either the start date or the due date in the various Outlook task lists. The color of the task flag indicates the due date.

- **Status** You can track the status of a task to remind yourself of your progress. Specific status options include Not Started, In Progress, Completed, Waiting On Someone Else, or Deferred. You also have the option of indicating what percentage of the task is complete. Setting the percentage complete to 25%, 50%, or 75% sets the task status to In Progress. Setting it to 100% sets the task status to Complete.

- **Priority** Unless you indicate otherwise, a task is created with a Normal priority level. You can set the priority to add a visual indicator of a task’s importance. The Low Importance setting displays a blue downward-pointing arrow, and the High Importance setting displays a red exclamation point. You can sort and filter tasks based on their priority.

- **Recurrence** You can set a task to recur on a regular basis; for example, you might create a Payroll task that recurs every month. Only the current instance of a recurring task appears in your task list. When you mark the current task as complete, Outlook creates the next instance of the task.

- **Category** Tasks use the same category list as other Outlook items. You can assign a task to a category to associate it with related items such as messages and appointments.

- **Reminder** You can set a reminder for a task in the same way you do for an appointment. The reminder appears until you dismiss it or mark the task as complete.

- **Privacy** Marking a task as private ensures that other Outlook users to whom you delegate account access can’t see the task details.
None of the options are required, but they can be helpful when sorting, filtering, and prioritizing your tasks.

To track tasks to completion, you can update the Status and % Complete settings in the task window.

**Tip** You can attach files to tasks, and you can include text, tables, charts, illustrations, hyperlinks, and other content in the task window content pane.

You can remove a task from your active task list by marking it as complete, or by deleting it. You can remove a flagged item from the active task list by removing the follow-up flag.

After you mark an instance of a recurring task as complete, Outlook generates a new instance of the task at whatever interval you specified when creating the task.

Removing the flag from a flagged item such as a message or contact record retains the item in its original location but removes it from your task list entirely.

➤ **To create a recurring task**

1. On the Task tab of the task window, in the Recurrence group, click the Recurrence button.

2. In the Task Recurrence dialog box, select the Recurrence pattern and Range of recurrence options you want, and then click OK.

➤ **To assign a task to a category**

➔ In your To-Do List or Tasks peek, right-click the category icon to the right of the task subject in the task list, click Categorize, and then click the category you want.

➔ Click the task in your Tasks List to select it. On the Home tab, in the Tags group, click the Categorize button, and then click the category you want.

➔ On the Task tab of the task window, in the Tags group, click the Categorize button, and then click the category you want.
Create and manage notes, tasks, and journals

To assign a due date to a task

- In your To-Do List or Tasks peek, right-click the flag icon, and then click the due date you want.

To mark a task as private

- On the Task tab of the task window, in the Tags group, click the Private button.

To mark a task as complete

- In the task window, set % Complete to 100%.
- On the Task tab of the task window, in the Manage Task group, click the Mark Complete button.

To delete a task

- In your To-Do List or Tasks peek, right-click the task subject, and then click Delete.
- On the Task tab of the task window, in the Actions group, click the Delete button.
- In the Tasks module, in the To-Do List or Tasks List, click the flagged item to select it. Then on the Home tab, in the Delete group, click the Delete button.

To remove a follow-up flag

- Display the Tasks module, click the flagged item to select it, and then click the Remove from List button in the Manage Tasks group on the Home tab.
- Click the flagged item in the Tasks peek, and then click the Remove from List button in the Manage Tasks group on the Task List tool tab.
- Right-click the flagged item, click Follow-up, and then click Clear Flag.

Create and manage notes

In the Notes module, you can create and store text notes about any subject. If your organization uses Exchange Server, the notes are available to you whenever you connect to your account through Outlook, through your Internet browser, or from a mobile device.

Tip: Outlook Notes support plain text, formatted text, and hyperlinks. You can’t format text within a note but you can paste formatted text from a document, message, or other source into a note and retain its formatting.
Some functionality of the Notes feature in Outlook 2013 has been modified from that of previous versions, as follows:

- The Notes folder is still available in the Folder List, and the Notes module is available from the Navigation Bar.

- Notes options are not available in the Outlook Options dialog box. You can create new notes, but only with the default color and font settings. (The note color does change to reflect any color categories that you assign to it.)

- Linking from a note to a contact record is no longer possible; however, you can attach a note to a contact record from within the contact record.

You can view the content of the Notes module in three standard views:

- **Icon view** This view depicts each note as a colored square with a turned up corner, reminiscent of a pad of sticky notes.

  In Icon view, you can display large icons organized in rows and columns, or small icons organized either in rows or in columns.

- **Notes List view** This list view displays a small icon, the note subject, and up to three lines of note content.

- **Last 7 Days view** This view is identical to Notes List view but displays only notes that have been modified within the last seven days.

In either list view, you can choose from two standard arrangements: Categories and Created Date. As with other list views, you can sort notes by a specific field by clicking the column header for that field, and you can add or remove fields from the list view.

**Tip** The first line of text in the note is shown as its subject.
You can organize notes by assigning them to color categories. In Icon view, uncategorized notes are depicted in the default color set in the Outlook Options window; categorized notes are depicted in the most recently assigned category color. You can also attach notes to other Outlook items, such as contact records.

➤ **To create notes**

→ In the Notes module, on the Home tab, in the New group, click the **New Note** button or press Ctrl+N.

→ In any module, press Ctrl+Shift+N.

**Tip** In Outlook 2013, Notes are not included on the New Items menu of other modules.

➤ **To assign one or more notes to a color category**

1. In the Notes pane, select the note or notes you want to assign to the same category.

2. On the Home tab, in the Tags group, click the **Categorize** button and then, in the list, click the category you want to assign.

➤ **To attach a note to a contact record**

1. Open the contact record window.

2. On the Insert tab, in the Include group, click **Outlook Item**.

3. In the Insert Item dialog box, in the Look in list, click the **Notes** folder, and then, in the Items list, click the note you want to attach.

4. In the Insert as area, do one of the following:
   - To insert the note content in the Notes pane of the contact record, click **Text only**.
   - To attach the note in the Notes pane of the contact record, click **Attachment**.
   - To create a link to the note in the Notes pane of the contact record, click **Shortcut**.

5. In the Insert Item dialog box, click **OK**.
### Create journal entries

The Outlook Journal feature provides an interface through which you can track, on a timeline, interactions with a specific contact.

Some functionality of the Journal feature in Outlook 2013 has been modified from that of previous versions, as follows:

- The Journal folder is still available in the Folder List, but is not available from the Navigation Bar.
- Journal options are not available in the Outlook Options dialog box.
- The automatic journaling functionality has been disabled. You can still create journal entries manually.
3.4 Create and manage notes, tasks, and journals

To display the Journal module

2. Press Ctrl+8.

To create a journal entry

1. In the Journal module, on the Home tab, in the New group, click the Journal Entry button or press Ctrl+N.
2. On the Journal Entry tab, in the Timer group, click the Start Timer button if you intend to time the interaction.
3. Enter a description in the Subject box, and then, in the Entry type list, select a transaction type.
4. Enter any additional notes.
5. When you complete the journal entry, stop the timer if it was running. Then in the Actions group, click the Save & Close button.
Practice tasks

There are no practice files for these tasks.

- From the To-Do Bar, create a task with the subject *MOS Dinner Reservations*, flag it for completion this week, and assign it to the Management category (or another category you choose).

- Open a new task window, and create a task with the subject *MOS Send Dinner Invitations*. Set a due date of next Tuesday with a reminder at 5:00 P.M., and then set the status to Waiting On Someone Else.

- Open the MOS Dinner Reservations task, mark it as private and high priority, and then set it to 25 percent complete.

- Create a new task with the subject *MOS Status Report* that must be carried out on the first Monday of every month for six months.

- In the Notes module, create a note that contains your full name.

- Modify the note content so that only your first name appears as the note subject, and your last name is in the note body.

- If you haven’t already done so, create a color category named *MOS*. Assign the note to the MOS color category.

- If you haven’t already done so, create a contact record for yourself. Attach the note to your contact record.

Objective review

Before finishing this chapter, ensure that you have mastered the following skills:

3.1 Create and manage calendars
3.2 Create appointments, meetings, and events
3.3 Organize and manage appointments, meetings, and events
3.4 Create and manage notes, tasks, and journals
Index

A
accepting meeting requests, 106, 108
access to accounts, delegating, 56, 57, 58
accounts
- applying rules to specific, 24
- delegating control, 57, 58, 91, 92
- multiple, 17, 18
Active view, 86
address books
- custom, 128, 129
- default, 127
- displaying, 128, 129
- printing, 35
- searching, 4
- sharing, 131
- social network, 128, 129
aliases, 4
appointment windows, opening, 96
appointments
- defined, 95
- cancelling, 105
- categorizing, 102
- changing time of, 102
- converting to meetings, 100
- copies, creating, 103
- creating, 96
- recurring, 101, 102
- reminders, 104, 105
Room Finder, 98
- scheduling, 95
- updating, 105
Arrange By list, 50
Arrange Meeting flag, 73
attaching files to tasks, 114
attachments
- described, 47
- forwarding and, 55
- opening, 32
- previewing, 31, 32
- printing, 37
- replying and, 55
- restricting, 51
- saving, 31, 32
- viewing, 31
Attachments tool tab, 31
attendees
- defined, 99
- adding, 108, 109
- inviting, 100
- optional, 99, 101
audio/visual equipment, scheduling for meetings, 99
automatic
- journaling, 118
- message processing, 21, 22, 23, 24, 25
- replies, 18, 19, 21
- signatures, 15, 16
automatically deleting suspected junk email, 82
availability for meetings, 86, 95, 98, 99, 100

B
background images, adding to message themes, 14
Bcc field, 46
Blocked Encodings List, 83
Blocked Senders list, 83
bookmarks within messages, 64
building blocks, 67, 68
business cards, 16, 32, 124, 130

C
calendar groups, 90, 91
calendar items
- grouping, 87
- importance indicators, 104, 105
- reminders, 104, 105
- searching, 39
- updating, 104, 105
Calendar module
- described, 2, 85
- accessing, 8
- delegating control of, 56
- peek, 8
- printing from, 37
Calendar view, 86, 87
calendars. See also meetings
appointments, 95, 96, 97
availability, 95
coworkers, 89
creating, 90
custom, 88
deleting, 91
displaying, 89, 90
events, 95, 97
grouping items, 87
internet, 89
multiple, 88, 89
permissions, 92, 94
printing, 33, 34, 37
publishing, 91, 92
secondary, 90, 91
sending, 92
shared, 89
SharePoint site, 89
sharing, 91, 92, 93, 94
sorting items, 87
switching views, 87
time scales, 87
time zones, 87, 88
viewing by time period, 87
viewing from other email accounts, 88
viewing multiple, 89
workday, 87
work week, 86, 87, 88
Call flag, 73
 cancelling meetings, 105, 109
categories
 described, 70
appointments, 102
assigning, 72
colors, 71
contact records, 126
custom, 73
names, 71
notes, 117
Quick Click, 71, 73
renaming, 72
replies, assigning to, 50
shortcut keys, 71, 72, 73
tasks, 113, 114
Cc field, 46
character spacing in messages, 59
charts, 65
cleaning up conversations, 76
clip art, 65
color
message categories and, 50, 70, 71
notes categories and, 117
of responses in messages, 13, 15
of text in outgoing messages, 12
comma-separated values (.csv) files
 exporting contact records to, 130, 134
 importing contact records from, 130, 132
comments, prefacing in messages with
described, 15
identifiers, 15
complete, marking tasks as, 115
conference rooms, finding for meetings, 98
contact cards, saving to Outlook, 32
contact groups, sharing, 131
contact records.
 described, 122
attaching notes to, 117
categorizing, 126
creating, 123, 125
deleting, 126
editing, 125
exporting, 130, 134
filin
setting, 124, 126
images in, 124, 126
importing, 130, 132, 133
vs. People cards, 125
printing, 38
searching, 39
sharing, 130
tasks, creating from, 112
types of information, 123
viewing, 127
Contacts folder, 127
Contacts module, delegating control of, 56
contacts, printing, 35
Content pane
 described, 7
printing from, 37
control of an account, delegating, 57, 58
Conversation view
described, 46, 75
displaying messages in, 76
managing messages with, 76
setting options, 77
showing senders, 75
turning on or off, 77
conversations
 cleaning up, 76
deleting current and future messages in, 77
deleting redundant messages, 77
expanding, 76, 77
headers, 75
ignoring, 76
indented view, 76
managing, 76
unread messages in, 75
converting appointments or events to
meetings, 100
copying
 restricting recipients from, 51
rules, 24
co-workers, sharing calendar information with, 91
.csv files. See comma-separated values (.csv) files
custom
    address books, 128, 129, 130
    appointment settings, 96
    building blocks, 67
    calendars, 88
    categories, 73
    contact record form, 123
    event settings, 97
    flags, 74
    Quick Steps, 29
    Search Folders, 41
    views, 3

data files, email accounts and, 17
Date Navigator, 8
declining meeting requests, 106, 108
Delay Delivery option, 53
delegating permissions
    accounts, 56, 57
    to calendars, 91
deleting
    all current and future messages in a
    conversation, 77
    calendar groups, 91
    calendars, 91
    contact records, 126
    hyperlinks, 64
    images, from contact records, 126
    Junk E-mail folder messages, 79
    messages, 56
    Quick Steps, 30
    redundant messages in conversations, 77
    rules, 25
    signatures, 68
    tasks, 114, 115
delivery options, 50
delivery receipts, 50, 53
directing replies to alternative email address, 53
displaying
    address books, 129
    calendars, 89, 90
    Folder Pane, 10
    Global Address List (GAL), 129
    Journal module, 119
    messages in Conversation view, 75
    messages in Reading Pane, 2
    modules, 8
    optional message header fields, 46, 48
    program window elements, 6
    search results, 39
    Styles pane, 62
distributing files, 47
Do Not Forward flag, 73
Dock The Peek button, 9
Done Quick Step, 26
due dates, assigning to tasks, 112, 115

eediting
    calendar items, 104
    hyperlinks, 64
email accounts, adding multiple, 17
email addresses
    entering, 4
    linking to, in messages, 64
email aliases, 4
email attachments. See attachments
e-mail rules. See rules
email signatures, 15, 16
emptying the Junk E-mail folder, 81
encrypting messages, 50
events
    defined, 95
    cancelling, 105
    converting to meetings, 100
    creating, 97
    reminders, 104, 105
    scheduling, 95
    updating, 105
Excel workbooks, distributing, 47
expanding conversations, 75, 76, 77
expiration, setting for messages, 50, 53
exporting
    contact records, 130, 134
    messages to Outlook data files, 33
fields, in message composition window, 46, 48
files
    attaching to messages, 48
    attaching to tasks, 114
    distributing, 47
    linking to, 63
    saving messages as, 32
filters for junk email, 82
flagging messages for follow-up, 49, 73, 74, 111,
112
Folder List, 128
Folder Pane
described, 7
    minimizing, 10
    resizing, 10
folders
creating, 4, 78
searching, 40
Follow Up flags. See also flagging messages for follow-up
adding, 49
available types, 73
removing, 114, 115
fonts
formatting text in messages, 59
themes and, 12, 14
For Your Information flag, 73
Format Painter, 60
formatting
global vs. local, 60
messages, 12
notes, 115
text in messages, 59
Forward flag, 73
forwarding
meeting requests, 106, 109
messages, 55, 56
removing priority settings, 52
restricting recipients from, 51
free/busy information, 95, 100
From field, 46
fundamental tasks in Outlook, 1

G
Global Address List (GAL), 4, 128, 129
global formatting, 60
graphics
of calendars, sending, 91
inserting, 65, 66
remote, 79
group scheduling, 90, 100
grouping calendar items, 87
grouping messages
by conversation, 75
by message setting, 50

J
journal entries, creating, 119
Journal module
described, 85
accessing, 8
displaying, 119
junk email
automatically deleting suspected, 82
Blocked Senders list, 83
protection level, 82
replying to, 79
Safe Recipients list, 83
Safe Senders list, 82
Junk E-mail folder
deleting messages from, 79
disabling active links and content in messages, 78
emptying, 81
managing junk mail settings from, 80
options, 82
processing messages, 81
purpose, 78
replying to messages in, 79
K
keyboard shortcuts, assigning for categories, 71, 72, 73

L
List view, 86
local formatting, applying to text, 59
locations for meetings, 98
Low Importance indicators, 51
Lync
  automatic replies and, 19
  Missed Calls Search Folder, 41
  Missed Conversations Search Folder, 41

M
Mail module
  described, 2
  accessing, 8
  creating messages, 48
  Quick Steps, 28
MailTips, automatic replies and, 19
managed resources, 98, 99, 100
marking messages as read or unread, 54, 55
marking tasks as complete, 114, 115
marking tasks as private, 113, 115
meeting locations, available, 98
meeting requests
  defined, 97
  forwarding, 106, 109
  Microsoft OneNote and, 108, 109
  previewing calendar and, 107
  proposing a new time, 106, 107, 108
  requirements, 99
  response options, 106
  tentative, 107
  updating, 104, 105, 108, 109
meetings
  attendees, 99, 100, 101
  cancelling, 105, 109
  categorizing, 102
  changing time of, 102
  conference rooms, 98, 99, 100
  copies, creating, 103
  notes, sharing, 109
  optional attendees, 99, 101
  recurring, 101, 102
  reminders, 104, 105
  replying to a message with, 54, 100
  Room Finder, 98, 101
  scheduling, 97, 98, 99, 100, 101
  updating, 105, 108, 109
message headers
  described, 2
  fields, 46
  read status and, 54
message responses, formatting, 13
messages
  addressing, 4
  appointments, creating from, 97
  attachments, 31, 32, 33, 47, 48
  automatic replies, 18, 19, 21
  automatic signatures, 15, 16
  blocking, 83
  categories, 50
  conversations and, 75, 76, 77
  creating, 48
  creating appointments from, 97
  deleting, 56
  delivery options, 50
  delivery receipts, 53
  digitally signing, 50
  expiration, setting for, 50, 53
  exporting to Outlook data files, 31, 33
  flagging for follow-up, 73, 74
  flags, 49
  formatting, 14, 15
  formatting text, 59
  forwarding, 55, 56
  graphics, 60
  grouping, 50, 75
  hyperlinks, 63, 64
  importance indicators, 49, 51, 52
  junk email, 78, 79, 80, 81, 82
  managing, 45
  marking as read or unread, 54, 55
  moving between folders, 78
  opening, 2
  outgoing, defaults for, 12, 13
  out-of-office, 18
  printing, 33, 37
  processing automatically, 21, 22, 23, 24, 25
  read receipts, 53
  reading, 2
  recipients, 4
  reminders, 49
  replying only to message sender, 55
  replying to all recipients, 55
  responding to, 54, 55
  responses, 13, 15
  restricting permissions, 51
  rules, 21
  saving as files, 31, 32
  scheduling, 53
messages (continued)
  searching, 39
  sending, 46
  sending account, selecting, 17, 18
  sensitivity indicators, 49, 52
  sorting, 50
  status, 54
  tables, 60
  tasks, creating from, 112
  themes and, 12, 13, 14
  tracking options, 50
  transferring to task list, 112
  voting options, 50, 52
Microsoft Excel. See Excel workbooks
Microsoft Lync. See Lync
Microsoft OneNote. See OneNote
Microsoft PowerPoint. See PowerPoint presentations
Microsoft SharePoint. See SharePoint contact lists; SharePoint site calendars
Microsoft Word documents. See Word documents
  minimizing the Folder Pane, 10
Missed Calls Search Folder, 41
Missed Conversations Search Folder, 41
modules
  changing order of, in Navigation Bar, 11
  displaying, 8
Move to Quick Step, 26
moving messages between folders, 78
multiple calendars, 88, 89
multiple email accounts
  managing, 17, 18
  viewing other calendars, 88

N
naming categories, 71
Navigation Bar
  described, 8
  compact vs. standard, switching between, 10
  customizing, 9, 10, 11
Navigation Pane. See Folder Pane
New button, 3
No Response Necessary flag, 73
notes
  attaching to contact records, 117
  categories, 117
  creating, 117
  formatting, 115
  subject field, 116
  tasks, creating from, 112
notes from a meeting, sharing, 109

Notes module
  described, 85, 115
  accessing, 3
  delegating control of, 56
  views, 116

O
OneNote, 108, 109
OOF messages, 18, 20
optional attendees, 101
outgoing messages
  attaching items to, 47
  defaults for, 12, 13
  flagging for follow-up, 74
  sending account, selecting, 17
Outlook Data files
  creating, 33
  email accounts and, 17
  exporting contact records from, 134
  exporting messages to, 33
  importing contact records from, 132
Outlook fundamental tasks, 1
Outlook information types, 5
Outlook items
  attaching to messages, 47, 48
  categories and, 70
  creating, 3
  flagging for follow-up, 74
Outlook Options dialog box, 11, 12, 13
Outlook profile, 17
out-of-office messages, 18, 20
Overlay Mode, for secondary calendars, 91

P
paragraph attributes in messages, 59
participants. See attendees
PDF files, printing contact records to, 35
peeking at module content, 8, 9
People cards
  displaying, 127
  vs. contact records, 125
People module
  described, 127
  accessing, 8
  peek, 9
  printing from, 38
People Pane, 7
percent complete setting, for tasks, 114
Permanently Delete Suspected Junk E-Mail option, 82
permissions  
delegating, 56, 57, 58  
restricting, for messages, 51  
sharing calendars, 92, 94  
Personal Stationery page, 12  
phishing. See junk email; Junk E-mail folder  
Phone Directory print style, 36  
pictures  
distributing, 47  
in contact records, 126  
in messages, 65, 66  
pinning peeks to the To-Do Bar, 9  
Plain Text format, 12  
PowerPoint presentations, distributing, 47  
prerequisite skills and experience for this exam, 1  
Preview view, 86  
previewing  
attachments, 32  
effect of styles on text, 62  
printing  
address books, 35, 36  
attachments, 37  
calendars, 33, 34, 37  
contact records, 35, 36, 38  
items, 36, 37  
messages, 33, 37  
restricting recipients from, 51  
tasks, 38  
priority settings  
for messages, 51, 52  
for tasks, 113  
private, marking tasks as, 113, 115  
processing messages automatically, 21, 22, 23, 24, 25  
profile, multiple email accounts, 17  
program options, configuring, 11, 12  
program window, customizing, 6  
proposing a new meeting time, 106, 107, 108  
.pst files, 33, 130  
publishing calendars, 91, 92

resetting, 30  
setting up, 28  
vs. rules, 26  
Quick Styles gallery, 62

R
read, marking messages as, 54, 55  
Read flag, 73  
read receipts, 50, 53  
read status, 54  
Reading Pane  
described, 7  
displaying messages in, 2  
message categories and, 71  
previewing attachments, 31, 47  
recent searches, 41  
recurring  
appointments, 101, 102  
tasks, 110, 113, 114  
redundant messages, deleting from  
reminders  
Calendar items, 104, 105  
messages, 49, 73, 74  
tasks, 113  
remote graphics, 79  
renaming categories, 72  
Reply & Delete Quick Step, 26  
Reply flag, 73  
Reply To All flag, 73  
replying  
described, 54  
automatically, 18, 19, 21  
to all message recipients, 54, 55  
to message sender only, 55  
vs. responding, 54  
with a meeting, 54  
requests. See meeting requests  
rescinding delegated permissions, 58  
resetting  
messages to default theme, 14  
Quick Steps, 30  
resizing  
Folder Pane, 10  
To-Do Bar, 10  
resources for meetings, scheduling, 100  
responses to meeting requests, 106, 108  
responses to messages  
automatic, 18, 19, 21  
formatting, 13, 15  
vs. replies, 54  
restricting message permissions, 51  
Review flag, 73
ribbon settings, 11
Room Finder, 98, 101
rules
  defined, 21
  applying to specific accounts, 24
  automatic replies, 22, 25
  copying, 24
  creating, 23
  criteria, 21
  deleting, 25
  modifying, 24
  out of office, 25
  running, 25
  standard templates, 22
  vs. Quick Steps, 26

S
Safe Lists Only option, 82
Safe Recipients list, 83
Safe Senders list, 82
saving attachments, 47
saving messages as files, 32
scheduling
  delivery of messages, 53
  meetings, 97, 98, 99, 100, 101, 102
  Room Finder, 98
  tasks, 111
Scheduling Assistant, 97, 99, 100
scope of searches, refining, 40
screen shots, inserting in messages, 65
Search Folders, 41, 42
Search tool tab, 39, 40
searching
  address books, 4
  categories, 39
  folders, 40
  narrowing results, 39
  previous results, viewing, 41
  scope, changing, 40
secondary calendars, 90, 91, 92
security
  digitally signing messages, 50
  program options, 11
semicolons, multiple recipients and, 4
Send E-mail flag, 73
Send Letter flag, 73
sending accounts, 17, 18, 46
sensitivity indicators, 49, 52
SharePoint contact lists, importing, 130, 133
SharePoint site calendars, 89
sharing
  address books, 131
  calendars, 89, 91, 92, 93, 94
  contact groups, 131
  contact records, 130, 131
  custom address books, 130
  meeting notes, 109
shortcut keys
  assigning to categories, 71, 72, 73
  assigning to Quick Steps, 28
Side-By-Side Mode, for secondary calendars, 91
signatures
  automatic, 15, 16
  deleting, 68
  manual, 68
Signatures And Stationery dialog box, 12, 14
skills and experience assumed for this exam, 1
SmartArt graphics, 65
social network address books, 128, 129
sorting
  calendar items, 87
  messages, 50
status of tasks, 113
styles, applying to text in messages, 61, 62
Styles pane, 62
switching views, 3

T
tables, 60
Tags dialog box, 50
task lists
  flags and, 73, 111
  transferring messages to, 112
tasks
  attaching files to, 114
  categories, 113, 114
  creating, 110, 111, 112
  deleting, 114, 115
  due dates, assigning to, 112, 115
  marking as complete, 114, 115
  marking as private, 113, 115
  percent complete, 114
  priority, 113
  recurring, 110, 113, 114
  reminders, 113
  scheduling time for, 111
  searching, 39
  status, 113, 114
  viewing all, 111
Tasks module
  described, 85
  accessing, 8
  delegating control of, 56
  peek, 9, 111
  views, 111
Team Email Quick Step, 26
Tentative status, 106
tentatively accepting meeting requests, 106
text
applying styles to, in messages, 61, 62
formatting in messages, 12, 59
themes
applying to messages, 60, 61
changing, 14
default, 12, 61
resetting to default, 14
Themes gallery, 60
time
changing for appointments, 102
proposing new for meetings, 108
scheduling meetings, 97, 98, 99, 100
setting for message delivery, 50, 53
zones, setting, 87, 88
To-Do Bar
described, 7
resizing, 10
To field, 46
To Manager Quick Step, 26
tracking
interactions with a specific contact, 118
messages, 50
tasks, 114
transferring messages to task list, 112

U
underlining text in messages, 59
Unread Mail Search Folder, 41
unread messages
conversations and, 75
marking, 54, 55
updating
calendar items, 105
meeting requests, 105, 108, 109
URLs in messages, 63

V
vCard files, 130
views
in Calendar module, 86
in Notes module, 116
in Tasks module, 111
switching, 3
virtual business cards, 130
viruses, attachments and, 31
voting options, 50, 52

W
web beacons, 79
webpages, linking to, 64
Word documents
distributing, 47
linking to, 63, 64
workdays, setting, 87, 88
work week
defined, 86
default, 87
setting, 88

X
XPS files, printing contact files to, 35

---

XPS files, printing contact files to 147